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Objectives

Administrators and grading coordinators will…

1. Know how to set up and use the BB Gradebook Overview Tool

2. Understand key inquiry questions (and limitations) of the tool

3. Learn about the new Teacher Export functionality

4. Optional: Have time to set up their own school document.



Agenda

Intro and The Why:  10 min
Setup  5 min
Gradebook Overview  25 min
Teacher Exports *new* 10 min
Deep Dive Tabs time permitting
Optional Time to Explore 30 minutes



The Tool CAN... The Tool CANNOT...

Provide high-level practice 
overviews.

Dictate assignment counts or 
weights.

Drill down to student/assignment 
levels.

Define when a student "should" 
earn a D/F.

Highlight inconsistencies in student 
experience.

Evaluate the rigor of classroom 
instruction.

Prompt data-driven inquiry. Explain why a student is 
struggling.

Expectations



Resources & Support

BB Gradebook Tool (make a copy here)

School-Based Grading Coordinator

SIS Calendar Events

For Assistance:
ITS Service Desk: (773) 553-3925, Option 2

Contact: grades@cps.edu

https://docs.google.com/spreadsheets/d/1zYY-xUojinQIWGxmBCqDyQnCerPgGaFaWbVbI8gtsMU/template/preview
https://forms.gle/fKXg4S969MzYc1Vp7
https://www.cps.edu/sites/sis/calendar/?calendars=1147


The Admin 
Perspective

The Vision

Goals

Current Practice

What does a "healthy gradebook" 
mean to your school?

What would you like to implement 
to better monitor student 

progress?

What systems do you use to ensure 
grades are accurate and posted on 

time?

What specific indicators are you looking 
for when auditing gradebooks or pulling 

Aspen reports?

REFLECTION



Current Practices



How Strong are your Gradebook Management / Review Practices?

2

3

5

6

7

8

1 4



What are you currently using to review gradebook Practices?

1. Honestly, I don’t really (yet, growth mindset)
2. 5 Week Powerfiles
3. Aspen: Clicking through Individual Reports
4. Aspen: Built in Reports (Aspen grade reports)
5. Using google forms or rubrics with specific look fors
6. BB Gradebook Overview
7. Chavez Report
8. Other

https://docs.google.com/document/d/1pnn4iWjFggabq3C2aTwqPbULjD9TBWnHjBdZ5P9AHZ8/edit
https://docs.google.com/spreadsheets/d/1zYY-xUojinQIWGxmBCqDyQnCerPgGaFaWbVbI8gtsMU/template/preview
https://co-ps-chavez-sites-w02.cps.k12.il.us/reports/


What are you currently using to review gradebook Practices?

This tool aims to be:
1. Quicker than clicking gradebook to gradebook
2. More timely than waiting for 5 week Powerfiles…
3. More comprehensive than currently built Aspen reports…
4. Full of embedded inquiry questions for admin who are 

beginning their practice



What kind of things are you looking for in your gradebook reviews?



Aligning Supports

● Are teachers giving similar work loads?
● Is there equitable use of categories like 

homework and participation.
● Is there equitable use of missing/0 vs Inc/Exc

Pick a Question to Keep in Mind

● What is the cadence of assignments?
● Which categories are being used?
● Are different teachers using categories 

differently?
● What type of assignments are being 

given and how frequently?

● Where are there high numbers of Ds/Fs?
● Is this student struggling in just this 

class, or in all classes?

● What is the turnaround time for feedback in 
Classroom??

● Are there classes where everyone is getting 
100%

● When was the last time the teacher updated 
gradebook?

Consistency and Best 
Practices

Equity

Genuine Timely 
Feedback



Gradebook Overview: 
Setup



How to setup the Gradebook Overview Tool
Note: Directions are also on the Setup Guide Tab

1. Make a copy of the BB Gradebook Overview Tool (Google Sheet)
a. Change the name to include your school and date

2. Get the Aspen Export
a. Download “All Assignments and Grades Export”

i. Aspen > School > Grades  > Transcript > Options > Export
ii. Leave default options (no teacher, CSV) unless you need a prior quarter
iii. Note: It may download automatically or you may have to click the hyperlink on the 

Aspen pop up window

3. Upload the report to the Import tab
a. On Import tab place cursor in top left (A1) cell (as if you were about to paste)
b. Go to File > Import

i. Upload: select file (note: you can drag and drop for downloads)
ii. Import File: “Import Location” change to “Replace file at selected cell”
iii. Import data

https://docs.google.com/spreadsheets/d/1zYY-xUojinQIWGxmBCqDyQnCerPgGaFaWbVbI8gtsMU/template/preview


Screenshot: Downloading



Screen capture: Uploading



Note: Teacher access to template

If they want, teachers can make their own copy of the 
template.

Staff > Gradebook > Options > Export >All Assignments and 
Grades Export for Staff



Gradebook Overview: 
Navigation



Navigation: Setup Guide

Setup Guide tells you how to download the Aspen Export (all 
assignments and Grades Export) and how to navigate the 
document



Navigation: Cadence Suggestion

Cadence Suggestion helps you determine what to look at each 
week of the 10 week grading cycle.



Navigation: Gradebook Overview

Gradebook Overview: This is where you will spend 90% of 
your time. It is the bulk of the report.



Navigation: Gradebook Overview

Deep Dive Tabs Other Tabs:
● Teacher Summary
● Student Class Grades
● Assignment Cadence/ Category Cadence
● Assignment Analysis
● Category Usage

As you go to the right, the tabs become more about digging deeper or answering very specific questions



Navigation: Teacher Export

Teacher Export *NEW*

Quickly create and update teacher facing copies of the tool which contains only their data. You can create 
a single teacher’s document, or all teachers at your school.  Teacher copies will be identical to the main 
template, except it will contain only their own info.

Note: Teachers also have access to update their own copy.



Navigation: Teacher Export: Permissions



Gradebook Overview: 
Using the Overview



Gradebook 
Overview Tab



1. Gradebook Overview

Hover Text

Hover over headers with a 
black triangle to see hover text. 
This will contain explanations, 
inquiry questions, and color 
coding descriptions

Hiding Columns

Use the + and - to hide 
and show sets of columns



1. Gradebook Overview

Navigation: 1 row = 1 gradebook for a single quarter

Yellow= 1 week past
Red = 2 weeks past

Purple is just high to low 
shading. Will highlight yellow 
if at least 2 ungraded 
assignments

Set the threshold 
(default is 70%)



1. Gradebook Overview

What this looks like in Gradebook



1. Gradebook Overview

Navigation: 1 row = 1 gradebook for a single quarter

Section What is shown Color Coding Inquiry Questions

Assignment 
Overview

● # of assignments
● # of students
● Last assignment date
● Last grade entered date

● # of assignments
● 2+ ungraded 

assignments
● 1 or 2 weeks 

since last date

● Are there sufficient assignments?
● Is timely feedback given?
● How does this align with school 

agreements and expectations?

Low 
assignment

● # of assignments for which 
the class average is below a 
certain threshold (default: 
70%)

● # of assignments ● Are there any assignments that the 
class as a whole struggled to master?

● What was that assignment?
● How did the teacher respond?



1. Gradebook Overview (pt 2)

Navigation: 1 row = 1 gradebook for a single quarter

Caution
There are certain practices and average modes which are valid but which cause 
incorrect letter grade calculations. 

For example, “Categories and Assignments” average mode will yield incorrect results 
here. Use this tool as a flashlight, but Aspen is always the source of truth.

Note
By default Inc, Blank and Exc 
are all ignored in grade 
calculation. 0 and MSG are 
counted as 0 in grade 
calculation.

https://docs.google.com/document/d/13sFQ0sqoz4gHuupZ43fyRcw8g2nFP2zb8eL2XS10cME/edit?tab=t.0


1. Gradebook Overview (pt 2)
What this looks like in Gradebook



1. Gradebook Overview (pt 2)
Section What is shown Color Coding Inquiry Questions

Estimated Grade 
Distribution

“If the quarter 
ended today.”

● Distribution of A,B,C,D,F
● Students with no 

assignments
● % D&F by gradebook
● Highest, lowest and average 

grade

Note: Certain valid practices 
can create inaccurate 
distribution estimates here

● Concentration of 
grades

● Concentration of 
No Grades (no 
assignments 
input)

● 0-100% for 
high/low/average

● Where are there significant Ds and 
Fs? 

● How does the teacher support these 
students? How does the school 
support these students?

● Are there students with no grades? 
Why? (e.g. new students, lack of 
engagement, lack of grade entry)

Code Usage ● # of individual Msg, Inc, 
Exc, and 0 given for 
assignments

● Yellow categories are 
ignored by gradebook 
averages. Red categories 
are counted 0 in gradebook 
averages.

● # of times the 
code is used

● Are there significant numbers of 
certain codes?

● If there are 0s, what is your school’s 
policy for assigning a 0?

● When is Inc/Exc used vs Msg? Is 
this consistent across classes?

● What are retake and late policies? 
Are these consistent?



1. Gradebook Overview (pt 3)

Navigation: 1 row = 1 gradebook for a single quarter

Note
This tool only sees categories that have been 
used this quarter. Yellow indicates utilized 
categories are less than 100. This might be 
okay early in the quarter. Red indicates utilized 
categories are more than 100%. This is almost 
always an error in gradebook setup.



1. Gradebook Overview (pt 3)
What this looks like in Gradebook



1. Gradebook Overview (pt 3)
Section What is shown Color Coding Inquiry Questions

Category usage ● Total % of category pie 
represented by 
assignments so far this 
quarter

● Name of categories 
represented

● # of assignments per 
category

● Category totals <100 
in yellow. Likely 
indicates that certain 
categories haven’t 
been used yet.

● Categories >100 in 
red. Likely indicates 
gradebook was set 
up with more than 
100 points assigned 
(e.g. duplicate 
categories or 
mis-distributed 
category weights).

● Have all categories been used (and 
should they have, depending where 
we are in the quarter)

● Do categories total 100%?
● Do categories have an appropriate 

distribution of # of assignments?
● Are there categories with few 

assignments, meaning each is 
more powerful toward the quarter 
grade? Does the teacher know 
those individual assignments are so 
powerful? 

● Are category weights appropriate? 
● Is there a school expectation that 

certain categories are used?
● Is there a school expectation that 

certain categories are consistent 
across class / grade / subject / etc?



Teacher Export *New*



7. Teacher Export

This new utility lets you make teacher facing copies of the template if you want your staff to see 
the same things you can.

Note: Copies are made on the drive of the admin that clicks the “Create” button. The folder is 
called [user name] Gradebook Overview. Click here to find yours if one exists.

https://drive.google.com/drive/search?q=%22gradebook%20overview%22


Admin: You can share the folder with your 
admin team. This will give them access to 
all teacher facing documents. It will also 
allow them to update the documents.

Make sure the documents and the folder 
are never set to “Anyone can view”

7. Teacher Export: File Permissions

Teachers: Share individual files with the 
specific teacher. The title of the file will 
change to reflect the most recent date 
updated, but the link for the teacher will 
always stay the same.



7. Teacher Export: Button Permissions

The first time you click the buttons on the document it will ask you for permissions. These 
permissions allow the automation to create the folder, update the dropdown, and copy and 
paste the information between the documents.



Deep Dive Tabs

2. Teacher Summary
3. Student Class Grades
4. Assignment Analysis
5. Category Usage
5b Category Counts
6a. Assignment Cadence
6b. Category Cadence



2. Teacher Summary

Navigation: 1 row = 1 teacher (across all classes)



2. Teacher Summary

Navigation: 1 row = 1 teacher (across all classes)

What is shown Color Coding Inquiry Questions

● When is the last time a 
teacher had an assignment 
due (in any class)

● When is the last time a 
teacher updated any grade 
(for any class)

● Yellow = 1 week +
● Red = 2 weeks +
● Color coding thresholds 

can be adjusted on this 
page, and will impact 
cadence color coding on 
the Overview page if 
changed here.

● Are teachers giving timely feedback?
● Are teachers giving assignments to assess 

mastery?
● What are the school expectations for 

assignment frequency?
● What are the expectations for timely and 

consistent feedback?



3. Student Class Grade

Navigation: 1 row per student per class (one transcript / report card mark)

Same Caution
There are certain practices and average modes which are valid but which cause 
incorrect letter grade calculations. 

For example, “Categories and Assignments” average mode will yield incorrect results 
here. Use this tool as a flashlight, but Aspen is always the source of truth.

Additionally, this assumes 90-80-70 grading scale and does not do Aspen’s 89.51=90 
rounding.

Same Caution
Sort by class, student, or teacher

https://docs.google.com/document/d/13sFQ0sqoz4gHuupZ43fyRcw8g2nFP2zb8eL2XS10cME/edit?tab=t.0


3. Student Class Grade

Navigation: 1 row per student per class (one transcript / report card mark)

What is shown Color Coding Inquiry Questions

● Estimated end of quarter 
grade per student in each 
class

● Sorter at the top can group by 
teacher, student or class

● Note: This assumes a 
100-90-80-70-60 scale and 
does not do Aspen’s rounding 
currently.

● Color coding based on A, 
B, C, D, F quarter grade 
projection

● Drill down from the grade distribution columns 
on the overview page

● Which students are struggling in a given 
class?

● Are student with Ds/Fs in one class also 
showing Ds/Fs in other classes?



4. Assignment Analysis

Navigation: 1 row per assignment per class (1 column in a gradebook)



4. Assignment Analysis

What is shown Color Coding Inquiry Questions

● Assignment category
● Weight of category
● Assignment Name & GB 

column name
● Class average on the 

assignment
● Due date of assignment
● Visibility (public/private)

● Green to red color 
gradient for class 
average (0-100%)

● What kind of assignments are being given?
● What does the page say about mastery of 

different content?
● Are there assignments where most of the class 

struggled? If so, what type of assignment was 
that? How much weight does that assignment 
have?

● When a whole class does not show mastery, 
how does the teacher respond? How is this 
different from when a single student or a small 
group of students fail to show mastery?

Navigation: 1 row = 1 assignment



5. Category Usage

Navigation: 1 row per category per class



5. Category Usage

What is shown Color Coding Inquiry Questions

● Class and Teacher
● Category Weight
● # of Quarter Assignments in 

this category

Note: Report only sees the 
original weights of categories 
used this quarter. It cannot 
identify which categories are 
unused, only if the weights 
don’t equal 100 yet (or if they 
equal more than 100).

● Category Weight 
yellow = total 
weight of 
categories used 
this quarter is <100

● Category Weight 
red= total category 
weights used this 
quarter >100

● What categories are used by each class?
● Have all categories been used this quarter? Should 

they have been by now?
● Is there consistency in category naming?
● Is there consistency in category weights across 

classes, subjects, grade bands, etc? Should there 
be?

● Are there potentially “overpowered assignments” due 
to categories with few assignments. 
For example, “Quizzes” category is 40%. “Exam” 
category is 30%. But this quarter only 1 quiz was 
given. That means that quiz carries the full 40% and 
is more powerful than the exam. There is no flag for 
this in Aspen and the teacher might not have 
intended for that to happen.

Navigation: 1 row = 1 assignment



5b. Category Counts

Navigation: 1 row per Category Name & Code combo



5b. Category Counts

What is shown Color Coding Inquiry Questions

● Category Name & Code 
combos

● Weight of the category
● # of classes that use 

different weights

Note: Report only sees the 
original weights of categories 
used this quarter. Yet to be 
used categories do not show 
up.

● N/A ● What kind of categories are used in the school?
● How consistent or varied are the weights used for 

those categories across classes?
● How are specific categories like Homework or 

Participation weighted?
● What kind of agreements (if any) are there for use of 

specific codes and weights by grade band, subject, 
school, etc?

Navigation: 1 row = 1 assignment



6a. Assignment Cadence

Navigation: 1 row per class (per gradebook)



6a. Assignment Cadence

What is shown Color Coding Inquiry Questions

● # of assignments due during 
specific weeks of the quarter

● N/A ● How many assignments are being given in 
classes? Are they spread out or concentrated 
in certain weeks?

● Is there a good cadence of assignments to 
assess student mastery during the quarter?

● Does the school have certain expectations of 
# of assignments per week? If so, are those 
being met?

Navigation: 1 row per class (per gradebook)



6b. Category Cadence

Navigation: 1 row per class per category



6b. Category Cadence

What is shown Color Coding Inquiry Questions

● # of assignments due during 
specific weeks of the quarter 
separated by category

● N/A ● How are different types of assignments 
distributed during the quarter?

● Are the type of assignments and cadence 
appropriate?

Same questions from previous page
● How many assignments are being given in 

classes? Are they spread out or concentrated 
in certain weeks?

● Is there a good cadence of assignments to 
assess student mastery during the quarter?

● Does the school have certain expectations of 
# of assignments per week? If so, are those 
being met?

Navigation: 1 row per class (per gradebook)



Reflection & Questions



Resources



Gradebook Audit Cycle (in progress)

Week Look For
Additional Gradebook Reports (For School Administrators and Grading Coordinators)
Aspen Reports for Grade Management

W1: Gradebook Fidelity ● Do any Gradebooks have Default Mode Gradebook Health Check: Classes w/out Average Mode & Category Weight Distributions

W2: Building Habits
● Have assignments been created and grades started to be entered?
(Tabs: 1. Gradebook Overview & 6a. Assignment Cadence) Blank, Msg, Exc & Zero Assignments by Teacher Report

W3: Early Warning
● # of Students with Ds and Fs
(Tab: 1. Gradebook Overview) ● Grade Threshold Export (formerly the Failure Report)^

W4: Second Chances

● Any assignments where the whole class struggled?(Assignment Analysis)
● Missing Grades/INC
(Tab: 1. Gradebook Overview) *Assignment that brings down the student's grade: Student Advantage Report Staff View

W5

● Misuse of Extra Credit
● Missing Grades/INC
● Grade Posting Happening
(Tab: 3. Student Class Grades)

Field set & Filter view for Extra Credit audit
Grade Threshold Export (for Grades Above 105%)
Blank, Msg, Exc & Zero Assignments by Teacher Report
Aspen - CPS Grade Validation Export

W6: Gradebook Fidelity

● Any obvious categories and Weights errors?
● Use of 0/MSG aligned with school expectations
(Tab:1. Gradebook Overview)

W7: Building Habits
● Grading fidelity: does every kid have the same grade (Tab: 3. Student 
Class Grades)

W8: Early Warning

● Have all categories and weights been used?
● # of Students with Ds and Fs
(Tabs: 5.Category Usage & 3. Student Class Grades)

● Unused Categories Filter
● Grade Threshold Export (formerly the Failure Report)^

W9: 2nd Chances

● Inc/MSG that need to be turned in
● Any assignments where the whole class struggled?
(Tab: 1. Gradebook Overview) *Assignment that brings down the student's grade: Student Advantage Report Staff View

W10

Grade Posting:
● Are there blank transcript grades? Why?
● Does the Gradebook Average match with the Transcript Grade?

Grade Validation Export; Grade Verification Report
Aspen - CPS Grade Validation Export
Aspen - Posting and Verifying Grades (Main Office)
CPS Enhanced Merge for Duplicate Transcript Records
Aspen Quick Guide: Posting Grades for Main Office
Gradebook Scores Post Column Audit
Kindergarten Report Card Resources

https://docs.google.com/document/d/1pnn4iWjFggabq3C2aTwqPbULjD9TBWnHjBdZ5P9AHZ8/edit#heading=h.ayd6lnavbskv
https://docs.google.com/document/d/1baQMsnw6SKGK1cr8G9LtJXIrwoYKQRN4kSXVlJ8pFfk/edit#heading=h.5fybnxvdfm8w
https://docs.google.com/document/d/1dw0dWJVDe9C5cfwbLk-gtSdnliSpisqe2Wh_h8T4XnQ/view#heading=h.xc0qyeijyovv
https://docs.google.com/document/d/1pnn4iWjFggabq3C2aTwqPbULjD9TBWnHjBdZ5P9AHZ8/edit#bookmark=id.7lihgx19imrr
https://docs.google.com/document/d/1Dt7tZpj-c6w58MZegtFDfA4hU1VqJHZKibAJQNdBP74/preview
https://docs.google.com/document/d/1dw0dWJVDe9C5cfwbLk-gtSdnliSpisqe2Wh_h8T4XnQ/view#heading=h.2ll415ffye1l
https://docs.google.com/document/d/1dw0dWJVDe9C5cfwbLk-gtSdnliSpisqe2Wh_h8T4XnQ/view#heading=h.2ll415ffye1l
https://docs.google.com/document/d/1dw0dWJVDe9C5cfwbLk-gtSdnliSpisqe2Wh_h8T4XnQ/view#heading=h.xc0qyeijyovv
https://docs.google.com/document/u/0/d/1TXmu1H4BfQYjdUgZSB7gtv7OtRpKhLpBLd-iMwwRslU/edit
https://docs.google.com/document/d/1dw0dWJVDe9C5cfwbLk-gtSdnliSpisqe2Wh_h8T4XnQ/view#heading=h.fa8p2bhxcy1p
https://docs.google.com/document/d/1pnn4iWjFggabq3C2aTwqPbULjD9TBWnHjBdZ5P9AHZ8/edit#bookmark=id.7lihgx19imrr
https://docs.google.com/document/d/1Dt7tZpj-c6w58MZegtFDfA4hU1VqJHZKibAJQNdBP74/preview
https://intranet.cps.edu/academics/ece/grades-k-2/kindergarten-report-card/
https://docs.google.com/document/u/0/d/1TXmu1H4BfQYjdUgZSB7gtv7OtRpKhLpBLd-iMwwRslU/edit
https://docs.google.com/document/u/0/d/1CAKZ2voRQIRnX-Wr_MQkz0TZDOh6mpGQBlaluALuPa0/edit
https://docs.google.com/document/u/0/d/1cghcsC16JmDk2Z7OIWN-NqEs1MmQ-7-2Xk3zqj2e1Vs/edit
https://docs.google.com/document/u/0/d/1JwzOHJZ6Afvv0DNGOaNVHfgAAkF8QOCS8ZRjE9Cxyis/edit
https://intranet.cps.edu/academics/ece/grades-k-2/kindergarten-report-card/


Exit Ticket

https://docs.google.com/forms/d/e/1FAIpQLSeiKZx8DN1kZI_oDP9pGjA0F6a-G5ytZa2nY3nxiFMPsC8yWg/viewform


Time to Explore
Make a copy

https://docs.google.com/spreadsheets/d/1zYY-xUojinQIWGxmBCqDyQnCerPgGaFaWbVbI8gtsMU/template/preview

